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LLEHTPAJIEH PETUCTAP HA PENYB/IMKA MAKEAOHUIA

6yn. KyamaH Jocudocku Muty 6p.1 1000 Ckonje
www.crm.com.mk
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BOBEA

Lenta Ha oBOj AOKYMEHT € Aa AagaTt MHCTpykuum ("how to" instructions) n ynaTcTBa Kako KAMEHTOT HajlecHo ga nogHece
OOKYMEHTaLMja NPeKy cuctemuTe 3a eNeKpPOoHCKOo nogHecyBake Ha LleHTpanHuoT Pernctap Bo Internet Explorer n Mozilla Firefox.

HAITIOMEHA

MoTNMWyBaHETO CO AUTUTANEH ENEKTPOHCKM CEPTUOUKAT HEe € OBO3MOXKEHO NPEKY UHTEPHET npenncTyBadyoT Google Chrome.
ENeKTPOHCKMOT cucTeM HajcTabunHo paboTu co MHTepHeT npennctyBadoT Mozilla Firefox.

3a MHCTanaumja Ha aUrnTaneH eNekTPOHCKN cepTudUKaT of oduumjanHuTe M3gaBadkm Kyku KMBC 1 Tenekom, umaTe ogpeneHn
ynaTcTBa M MHCTaNaLMOHW NAaKeTU Kou BU ce NOTpebHM 3a KopUcTere Ha UCTUTE U MOXKETE Aa MM HajaeTe Ha CefHUBE IMHKOBU
http://ca.kibs.com.mk/support/PomosMK.aspx -3a KNBC u https://ca.telekom.mk/upatstva.htm - 3a Tenekom.

Kako fa nposepam Aaav cepTU(PUKATOT e 400p0 MHCTaAVpaH?

Hoxonky umare cepruduxat Ha BCEII (Token) Bep6a K2 unu Bep6a I1po2, notpedHo e na ro umare
MHCTAIUPAHO COOJBETHHOT codTBep 3a Gemalto Bep3uja 6.3 ¥ UCTHOT /1a TO PUKIYYUTE BO KOMIIjyTEPOT.
JIOKOJIKY BO JOJTHHOT JIECEH arojl Ha BalllMOT MOHUTOP TO UMATe CIETHHOB 3HAK

Customize...

10:10
15.03.2016

= E |Ir ':J=:| |':.

BammoT TokeH He € 1oOpo MHCTAIMpaH U Ke MOpa Ja I'M JOMHCTAJIMpAaTe ApajBEpUTE 3a UCTUOT, HAaBEIEHU BO
muHKOT Ha crpanara Ha KWMBC.Ilo ycremHa wHCTaNanja u 3a0JDKUTEICH pecTapT Ha BAIIMOT KOMITjyTep
ukoHata 3a Gemalto mopa aa u3rnena Kako Ha CIMKaTa MOA0Jy Kako Ou OWJIe CUTYpHH JieKa BalllnOT TOKEH €
100pO MHCTAIMpPaH
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[Mopagu 3abenexxanu mpoOiemu co HajHoBaTa Bep3uja Ha Mozilla Firefox 42.0 Be um3BectyBame neka

CUCTEMOT € HajCTaOMJIEH CO:
- npemucryBador Mozzila Firefox Setup 41.0.2.eXe Koj IITO MOXKE Jia TO pe3eMeTe U MHCTATUpaTe HO
NPETXOAHO MOpa Jia TO IEUHCTAINpaTe HajHOBUOT
- TOTpeOHO J]a Cce UCKIIy4YH OIIIMjaTa 32 aBTOMATCKO aXypupame, BO MeHHTO 100IS ce n3bupa omnuuja
Options a motoa Bo Advanced ce cenektupa Never check for updates ...

we 9 3 A O

M cut Tg Copy Open menu
- 100% +
Mew Window  New Private Save Page [l Genera @
e Priva Advanced
Q Search
5 46) _ General Data Choices Networlk Update Certificates
N E Content
Print History Full Screen
M Applications Firefox updates:
p O i Automatically install updates (recommended: improved security)
Warn me if this will disable any of my add-ons
Find Options Add-ons a Securtty Check for updates, but let me choose whether to install them
() Sync | @ Never check for updates (not recommended: security risk) l
d ._é, Advanced Show Update History
Developer Synced Tabs | D Use a background service to install updates
€ Signin to Sync Automatically update:
v | Search Engines
Customize [7] O
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https://ftp.mozilla.org/pub/firefox/releases/41.0.2/win32/en-US/Firefox%20Setup%2041.0.2.exe

Internet Explorer 9, 10 and 11 (Win) — bpumeme na Cache u
Cookies

1. Usoepere Tools (via the Gear Icon) > Safety > Delete browsing history....

3abesemka: Moere /1a MpUCTAUTE O MEHUTO CO MpeTUCKame Ha Komunmara Ctrl + Shift +
Delete.

= aboutblank ~ |2 | X I = Blank Page
Print k
File 3
Zoom (100%5) k
( Delete browsing history... J Ctrl+Shift+Del »
InPrivate Browsing Ctrl+5Shift+P View downloads Ctrle)

Tracking Protection...
v ActiveX Filtering
Webpage privacy policy...

Manage add-ons
F12 developer tools
Go to pinned sites

Check this website R T

Turn off SmartScreen Filter... T BT

Report unsafe website -

2. Ocwurypere ce Jieka cTe ro oTmTukiaupane Preserve Favorites website data u geka cte ru
mrrukiaupaie Temporary Internet Files u Cookies mortoa kiukaere Delete.
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reserve Favorites website data

kKeep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

ll emporary Internet files

Copies of webpages, images, and media that are saved for faster
viewing.

u-u kies

Files stored on your computer by websites to save preferences
such as login information.

|:| History
List of websites you have visited.

["| Download History

List of files you have downloaded.,

["| Form data
Saved information that you have typed into forms.,

[] Passwords
Saved passwords that are automatically filled in when you sign in
to a website you've previously visited.

[ InPrivate Filtering data

Saved data used by InPrivate Filtering to detect where websites may
be automatically sharing details about your visit.

About deleting browsing history

3. Ke 106uTte moTBp/a Ha JHOTO HA MPO30PELOT AeKa YCIELIHO cTe Ii n3bpuiaie cache i cookies.
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ﬁ _:. HE =) Blank Page

Internet Explorer has finished deleting the selected browsing history.

Mozilla Firefox — Bpumeme na Cache u Cookies

KnukseTe Ha MeHHU KormueTo (rope IecHo0) = u u3bepere Options.

1. Usbepete Advanced panel.
2. KnukHete Ha Network Tabor.
3. Bo Cached Web Content noneto,knnkHete Clear Now.

c f
@ Genera Advanced
Q) Search
General Data Chaoices Network Update Certificates
Content
Applicationg Connsction
Privacy Configure how Firefox connects to the Internet Settings

Security

Cached Web Content

Syme Your web content cache s currently using 350 MB of disk space Clear Mow

WETT o ache management
A Advanced Owerride automatic cache managemen
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4. Usracere ro about:preferences mposoperor. Cute npoMeHH aBTOMATCKHU Ke ce 3a4yBaar.

ABTOMAaTCKO Opulewme Ha cache
Moskete aa ro cerupare Firefox aBromarcku ma ro Opuie cache -ot xora ke ro uckinyuunte Firefox:

KnukHeTe Ha MeHH KomdeTo (rope JecHo) = u n3bepere Options.

MN3bepeTe ro Privacy panel.

Bo History noneto, cetupajte Firefox will: Ha Use custom settings for history.
KnukHeTte ga ro wtuknaunpate noneto Clear history when Firefox closes.

PwnNPE

Tracking
Request that sites not track you Learn More

v | Use Tracking Protection in Private Windows Learn more
Search
Content oy

Firefox will:| Use custom settings for history -
Applications

Always use private browsing mode

Privacy v | Remember my browsing and download history

Security v | Remember search and form history

v | Accept cookies from sites

SYNC

Accept third-party cookies:| Always -
Advanced

Keep until:| they expire v

v |Clea[ history when Firefox closes

5. OcseH Clear history when Firefox closes, KnukHeTe u Ha Settings... konyeTo. Settings for Clearing
History npo3opeuoT ke BK ce oTBOPM.
6. Bo Settings for Clearing History window, wtuknupajte ro noneto ogma ao Cache (cnvka nogone).
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Settings for Clearing History x

When I quit Firefox, it should automatically clear all:

History
Eﬁruwsing & Download History Cookies
Active Logins v | Cache

Form & Search History

Data
Site Preferences Offline Website Data

Ok Cancel Help

KnukHete OK 3a ga ro 3atBopuTe Settings for Clearing History nposopeuor.
3arBopeTte ro about:preferences nposoperor. Cure MPOMEHH IIITO CME T HAITPABUJIC aBTOMATCKHU Ke
ce 3a4yBaar.
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1 KOPUCHNYKO VITATCTBO 3A MICKAYYYBAIHE HA POP-UP BLOCKER

1.1 Internet Explorer

OtsoperTe ro Internet Explorer npenanctysayot. KnmkHeTte Ha meHuTo Tools > Pop-up Blocker > Turn Off Pop-up Blocker.

w4 | X |l=] Bing hr

File FEdit

View Favorites DG Help

= Favorites | —=:| TS = Delete Erowsing History... Ctrl+ Shift+ Del Add-ons = Iur Loremn Jpsum - All the fact..

InPrivate Browsing Ctrl+Shift+ P

€8 Blark Page %~ B 0 Ao~ Pagev Sefeyr Toohv @ T

Dagnose Connection Problems...

Reopen Last Browsing Session

InPrivate Filtering Ctrl+Shift-F
InPrrvate Filkering Sctings

Pop-up Blocker Turmn Off Pop-up Blocker

SmartScreen Filler ' Pog-up Blocker Setiings

Manzage Add-ons

Compatimlity View

Compatibility View Szttings

Subscribe to this Feed...

Feed Dscovery 3
Windows Update

Developer Tools F12
Fiddler2

Skype Plug-In
OneNete Linked Notes
Send to OnzNote

Intemet Oplions

Enzblz cr disable pop-up blocker. fa r HW0% v

Cnuka 1 - Internet Explorer
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1.2 Mozilla Firefox

OtBoperte ro Mozilla Firefox npebapysauyoT. KnukHete Ha meHuTo Tools > Options.

Eie Edit Miew. Higtory Bookmarks [Zonks) Help-

SO K A We Search K frefons@ris=orgamozillsen-Us.officis! - |48 Googte IR S

5 MostVisited _ Getting Started i

Lowmloads

Chrl-)

I dd-ors
3 mouilla Firefox Start Page 2

Web |meges Videos Maps Hew:

Javs Console

Firebug »
Skype Bt ension

Errar Cansole CirleShift-=
Htral Validator aptions..

PageInfc

Monitor with Eiddler v

Start Drivate Browsing  Chrls Shift-P -
Clear Recent History.., Cirl-Shifts Del Google

Dumimy Lipsum e
Options.. Googla Saarch
/ & DownloadHelper v
B3 sion un for moathly news and lasm how to get mora from your anfing ifs with Firafox!

About Mozilla - Firafox Suppoert

Fiddler: OFF (zuts]

& 4 0errors /83 warnings []

Cnwuka 2 - Mozilla Firefox

[loKO/IKY He BM ce NnojaByBa MeHUTO NOTPebHO e Aa KAMKHETe AeceH KWK Ha pamKata of,
npesncTyBavoT 1 noToa Aa oabepete Menu Bar

[ ‘ Mozilla Firefox Start P x-\' + | "" — |
7 ozilla Firefox Start Page \4 Reload All Tabs L
Bookmark All Tabs...

Undo Close Tab

%) Firefox | S=earch or enter address

@] Most Visited :: Getting Started u Touka - Hacnoexa MoTrka - Ce Ha Menu Bar Vil

v Bookmarks Toolbar

Customize...
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Bo Options ogbepete Content, noToa oTwTtnKAMpajTe ro Block pop-up windows n knMkHeTe Ha OK.

Gé;ral Tabs Content Applications Privacy  Security  Advanced

[] Block pop-up windows ‘ Exceptions...
Load images automatically

Exceptions...

s

Enable JavaScript Advanced...

Fonts & Colors

Default font: | Times New Roman vl Size: llﬁ v] Advanced...

Colors..,

Languages

Choose your preferred language for displaying pages

Ok | | Cancel | | Help

Cnuka 3 - Onumm Bo Mozilla Firefox
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2 KOPUCHUNYKO YITATCTBO 3A AOAABAIHLE HA CTPAHA BO TRUSTED SITES

2.1 Internet Explorer

OtBoperte ro Internet Explorer npenncrysayot. KnmkHete Ha meHuTo Tools > Internet Options. Ke ce oTBopu nposopel, Internet Options n og
npo3opeuoT nsbepete ro TaboT Security.
U3bepete Trusted sites M KNMKHeTe Ha KonyeTo Sites.

7 .
Internet Options |'? 2e |

Security | Privacy | Content | Connections | Programs | Advanced |

Select a zone to view or change security settings.

@ & v O

Internet  Localintranet Trusted sites  Restricted
sites

Internet
0 This zone is for Internet websites,

except those listed in trusted and
restricted zones,

93]
oL
o
L

Security level for this zone
Allowed levels for this zone: Medium to High
Medium-high
- Appropriate for most websites
== - Prompts before downloading potentially unsafe

content
- Unsigned ActiveX controls will not be downloaded

'| Enable Protected Mode (requires restarting Internet Explorer)
Custom level... | | Defaultlevel

Reset all zones to default leve

@ Some setiings are managed by your system administrator,

oK H Cancel | Apply

Cnuka 8 - Internet Options, Security tab
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Ke ce nojasu nposopeu, Trusted sites 1 Bo noneto ,,Add this web site to the zone" BHeceTe http://e-submit.crm.com.mk/ 1 KnAMKHeTe Ha
konuyeto Add. MoTtoa kankHeTe Ha KonyeTo Close Ha npo3opewoT Trusted sites n OK Ha npo3opeuoT Internet Options.

-

-
Trusted sites 22

ﬁ You can add and remove websites from this zone. All websites in

o

&Y this zone will use the zone's security settings.

Add this website to the zone:
Websites:
[ 2ecmummseara et | - Remove
=== | : |
| oo orm o e e | i
=
Esa stk o 2 oo B 2

Require server verification (https:) for all sites in this zone

Cnuka 9 - Trusted sites nposopeL,
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<
2.2 Mozilla Firefox

OtBoperte ro Mozilla Firefox npenuncrysayot. KnnkHeTte Ha meHuTo Firefox > Options > Options.

x | @ Moilla Firefox start

Mew Tab ’ij Bookmarks
? Start Private Browsing History 3
Edi b Downloads
il & Add-ons
Save Page As... Options 4 Options
Send Link... 3
kelp Menu Bar
- Frint ¥ Mavigation Toolbar
Web Developer » Bookmarks Toolbar
Foll Sreen Add-on Bar  Ctrl+/
Set Up Sync... Toolbar Layout...
Exit

Cnuka 10 — Options

Ke ce oTBopy nposopet, Options v Tamy U3bepeTe ro TaboT Security.

Options s
0 6& @ @@ @ %4

General Tabs Content  Applications  Privacy ~ Security  Sync Advanced

Warn me when sites try to install add-ons Exceptions...

Block reported attack sites
Block reported web forgeries

Passwords
Remember passwords for sites
[] Use a master password ‘ Change Master Password.., ‘

Saved Passwords..,

Cnuka 11 - Security Tab
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KnuKHeTe Ha Konueto ,Exceptions”. Ke ce otBopu nposopeuot Allowed sites. BHeceTe http://e-submit.crm.com.mk Bo noneto , Address or
website" 1 KankHeTe Ha KonyeTo ,Allow" 3a fa ja foaapeTe cTpaHaTa.
Mo pofasarbeTo Ha Beb cTpaHaTa KAMKHeTe Ha KonyeTo Close, a noToa Bo npo3opew,oT Options KAnKHeTe Ha KonyeTo OK.

You can specify which websites are allowed to install add-ons. Type the exact
address of the site you want to allow and then click Allow.

Address of website:

Allow

Site Status
addons.mozilla.org Allow
getpersonas.com Allow

[ Remove SiteJ [ Remove All Sites ]

Cnuka 12 - Allowed sites npo3sopel,
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3.IloaecyBarbe Ha HajHOBaTa Bep3uja Ha java

3.1 IIpu noTnumnyBame CO HajHOBaTa Bep3ja Ha java IIOTpeOHO e KAMEHTOT 4a IO HallpaBu

CAeAHOTO:
Bo Control Panel Tpeba aa nsbepe Java Control Panel
[a KnnKHe Ha KonyeTto View KaKo Ha cavKaTa:

{General}| update | Java [ security | Advanced

About

View version information about Java Control Panel.

Metwork Settings

Metwork settings are used when making Internet connections. By default, Java will use the network.
settings in your web browser, Only advanced users should modify these settings.

| Network Settings. ..
|l Temporary Internet Files

| Files you use in Java applications are stored in a spedal folder for quick execution later. Only
| adwvanced users should delete files or modify these settings.

| Settings... [ View. . ]

Java in the browser is enabled.

| |ShowtheJa\.ri

See the Security tab

o] (o ] [ oo

[a rv u3bpuiue cute pecypcu o4 iMcTaTa co cenekTuparse u n3buparbe Ha KonyeTo X Kako Ha cauKaTa:

o ——
|£| Java Cache Viewer —

S

Show: ’R.esowces - ] |§|

Installed Size: 0.0KB - Cached Size: 127 KB

[ !
[Remave selected resources [\, o

5/20/2014

Expired Version Size
127 KB
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Bo Tabort Security, aa ce usbepe konueto Edit Sitelist u aa ce gogaaat chegHuTe url-a:

http://e-submit.crm.com.mk/SSO/
https://e-submit.crm.com.mk/SSO/
http://e-submit.crm.com.mk/eFiling/
https://e-submit.crm.com.mk/eFiling/
http://e-submit.crm.com.mk/AAOL/
https://e-submit.crm.com.mk/AAOL/
http://e-submit.crm.com.mk/ePledgelLeasing/
https://e-submit.crm.com.mk/ePledgelLeasing/

Hanomena: [T T T 0T o - XTI T T AT T T I T

Ha npumep: http://e - submit.crm.com.mk/SSO/ [T T

http://e-submit.crm.com.mk/SSO/

| £ Java Control Panel El_lﬂ_hJ

| General | Update | Java | Security | Advanced

Enable Java content in the browser

Security level for applications not on the Exception Site list

) Very High - Only Java applications identified by a certificate from a trusted authority are
gllowed to run, and only if the certificate can be verified as not revoked.

@ High - Java applications identified by a certificate from a trusted authority are allowed to
run, even if the revocation status of the certificate cannot be verified.

Exceplion Site List
Applications launched from the sites listed below will be allowed to run after the appropriate security

(=19

prompts,
http: f/crm.com.mk/ P
hth::ffe-test.u’m.cc-m.mk ’ Edit Site List... l
http: f/e-test.crm. com.mk fePledgel easing -
Add, Remove, orE
Restore Security Prompts l ’ Manage Certificates... l
oK l [ Cancel Apply
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4.0Bo3MOXYBambe Ha goaarormre (Plug in) Bo mpeancryBadoT

4.1 Mozzila Firefox

,ﬂ,OKO/’IKy ce anaBM cnhegHaBa rpelka

LLEHTPAAEH PETUCTAP HA PENYBAWKA MAKEACOHMJA

This plugin has security vulnerabilities.
Auctivate Java,

nOTpeGHO € [a K/INKHEeTe BO TOPHUNOT J1EB aro/1 Kako WTO € NPUKa*KaHo Ha C/IMKaTa

_J-':. & Mo f&j"ﬂ-ﬂl—hﬁ MNoguwHm C.. % |,\_+

€ [ O e-test.om.commk/AAOL/admin/AASignPreview.aspx? AASessionld=3QXHILKP Ml

™
' Allow e-test.crm.com.mik to run plugins? _

‘- lava

| Block Plugin

|
A\ Vulnerable plugin!  What's the risk? e ] |
Java I Elock Plugin v“
[ oK | | Cancel |

W pBaTta gopatoka (Plugin) ga rv noctasute Ha Allow and Remember
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'JF % Mognecysarbe Moguwinm C.., ¥ Eﬁ'.\_+

é O r"f e-test.crm.com. mk/AAOL admin/AASignPreview.aspxtAASessionld=3QXHILKPN

o
n Allow e-test.crm.com.mk to run plugins? -

Java
A\ Vulnerable plugin!  What's the risk?

lALI:uw and Remember "]

——

Java F Mkpm v]

Allow Mow

l l Allow and Remember

| Block Plugin

MoToa nputncHeTe OK 1 HanpaseTe Refrash Ha cTpaHaTa

~
Hd

Do you want to run this application?

Name: mk.com.reaktiv.xsignapplet.Signature ...

Publisher: Ceniralen registar na Republika Make ...

Location:  http:/fe-test. crm.com.mk

This application will run with unrestricted access which may put your computer and personal
information at risk. Run this application only if you trust the location and publisher above.

/DDomtdmwﬂisangDramsﬁomﬁ'ﬁmbisfﬁrmdmﬁonaboue

E Mare Information . Run | [ Cancel

Ha nposopuyeTo of JaBa WTO Ke BM ce NojaBM KAMKHeTe Ha check box-0T 03HaueH Ha caunKaTa U KAMKHeTe Run
'

*

-/
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4.2 Tlopaka co KOja M3BecTyBa anaukKaiyjara geka uMa IIOHOBa Bep3uja Ha Java

[I0KONIKY BO MOMEHTOT Npu NOTNULIYBakbe MMa HOBa Bep3uja Ha Java aniuKaumjaTta Ke BM NojaBy NpPo3opeL, AaM cakaTe UCTaTa 4a ja
MHCTanupate BegHal WM NOAOLHA M Aa NPOAo KMTe co paboTa BO cucTeMoT

x e-testerm.com.mi/AA0L admin/Ak

LEHTPAAEH PETMCTAP HA PENYBAUKA MAKEAOHUJA é

Java Update Needed

V1 Your Java version is out of date.

+ Block

Block Java content from runrumg m this browser session,

+ Later
Cantinue and you will be reminded to update again Liter.

Do mot sk agasn wntil the rext update is available.

[oKosRy cTe Hemane npobnem co NOTNMLLIYBake MOXKeTe Aa u3bepete Later,Bo cnpoTuMBHO Ke Tpeba aa Hanpasute Update Ha
HajHOBa Bep3uja Ha Java.

5. IIpoGaemMu co mpuMarbe Ha Mana (camo 3a Mana aapecu oa aomenure hotmail, outlook n

live)

MocToun BepojaTHOCT Aa By ce cnyym Aa He NnpumuUTe Mau 3a U3BECTYBakbe BO YC/I0BM KOra CUCTEMOT mcnpaka ronem 6poj Ha e-maunn
ropaku KOH KOPUCHULM KOM MMaaT Mau agpeca of ropeHaBeeHnTe JoMeHu. Nopaam oBme npuunHm Tpeba aa ce HajaBuTe Ha
BalwmoT maun 1 aa ja usbepete onumjata More mail settings, Koja ce Haofa Bo ropHMOT AeceH aron og Bawunot npebapysau.
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Reading pane
Off

® Right

Bottom

Mare mail settings

Help
Feedback

MoTtoa ogete Bo genot Preventing junk email u knnkHeTe Ha Safe and blocked senders.

ai Outlook | v

M3bepeTe Safe senders.

OpflODS Inbox » Options

Managing your account Preventing junk email

Account details (password, addresses, time zone) Filters and reporting

Your email accounts Safe and blocked senders

Email forwarding

Customizing Qutlook

Sending automated vacation replies

POP and deleting downloaded messages Advanced piivac) setings

Create an Outlook alias Language

Rename your email address Keybeardshoricuts

Upgrade to Ad-free Outlook Rules for sorting new messages

Flagging
\"\."'riting emzil Instant actions
Formatting, font and signature
Reply-to address
Saving sent messages

Attachments

Reading email

Reading pane

Active view settings

Group by conversation and pre-load messages
Content from third-party networks

Default view after moving or deleting email

Reply Settings
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Safe and blocked senders  mbox » Options » Safe and blocked senders

Manage who is allowed to send you email. Messages from safe senders will not be sent to the junk email folder.

Safe mailing lists

Manage which mailing lists are sent to your account. Messages to safe mailing lists will not be sent to the junk email folder,
Blocked senders

Manage who is blocked from sending you email. Messages from blocked senders are automatically deleted.

Bo noneto Sender or domain to mark as safe sHeceTe esubmit@crm.org.mk un knankHete Ha Add to list>>.

Safe Seﬁders Inbox » Options » Safe and blocked senders » Safe senders

Messages from safe senders will not be sent to the junk email folder. You can mark specific email addresses as safe or mark a whole domain (the part of an email address after the @ sign).

To allow an email address or domain into your inbox, enter it in the box below, and then click Add to list. To remove an address or domain, select it in the list below, and then click Remove from list.

Sender or domain to mark as safe: Safe senders and domains:
esubmit@crm.org.mk Add to list > >
Example: name@example.com << Remove from list

Emaunn agpecata esubmit@crm.org.mk Tpeba aa ce nojasu Bo aenot Safe senders and domains.

Safe Seﬂders Inbex » Options = Safeand blocked senders = Safe senders

Messages from safe senders will not be sent to the junk email folder. You can mark specific email addresses as safe or mark a whole domain (the part of an email address after the @ sign).

To allow an email address or domain into your inbox, enter it in the box below, and then click Add to list. To remove an address or domain, select it in the list below, and then click Remove from list.
Sender or domain to mark as safe: afe senders and domains:

Add to list >> esubmit@crm.org.mk

Example: name@example.com << Remove from list
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